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SONAR	2016.09	Update	
	

Your	CPU	works	hard,	so	we’d	like	to	do	
what	we	can	to	help	it	work	more	
efficiently.	This	update	includes	Plug-In	
Load	Balancing	for	Platinum,	which	allows	
running	more	plug-ins	with	fewer	dropouts.	
For	users	of	all	versions,	there	are	also	new	
CPU	meter	modes	to	gauge	performance,	as	
well	as	Quick	Group	freezing—now	it’s	easy	
to	save	lots	of	CPU	power	by	freezing	
multiple	tracks	at	once.	

	
	
Finally,	for	your	reading	pleasure	we	review	a	MIDI	Bluetooth	keyboard	controller,	present	
another	fascinating	“Anatomy	of	a	SONAR	Project,”	fill	you	in	on	this	month’s	SONAR	Top	10	
chart,	alert	you	to	a	unique	educational	opportunity,	and	point	you	to	some	cool	forum	threads	
on	how	to	get	the	most	out	of	SONAR.	
	
So	what	are	you	waiting	for?	Read	the	eZine,	boot	up	SONAR,	and	enjoy	the	latest	updates	and	
enhancements.		–	The	Cakewalk	Team	
	
	

Plug-In	Load	Balancing:	Now	Platinum	owners	can	run	more	plug-ins,	with	fewer	
dropouts,	greater	efficiency,	and	more	even	distribution	of	CPU	loading	to	
processing	cores.	Recommended	for	systems	with	four	or	more	cores,	this	update	
can	improve	plug-in	performance	at	buffer	settings	of	256	and	above.	

	
CPU	Meter	Modes:	This	update	to	the	Control	Bar’s	Performance	module	extends	
the	ability	to	monitor	what’s	happening	with	your	CPU—including	monitoring	the	
global	CPU	consumption	across	all	cores	for	all	aspects	of	the	OS,	audio	processing	
load,	and	a	single	meter	for	SONAR’s	total	CPU	utilization.	

	
Quick	Group	Freeze:	After	taking	care	of	everyone	who	wanted	the	Quick	Group	
functionality	for	insert	effects,	now	there’s	Quick	Group	Freeze	so	you	can	freeze	
or	thaw	multiple	tracks	at	once.	Not	only	that,	but	with	the	new	metering	options,	
you	can	see	exactly	how	much	difference	it	makes.	

	
Full	Screen	Toggle	Button:	When	you	want	the	maximum	amount	of	screen	“real	
estate”	to	see	as	many	elements	as	possible	within	SONAR,	the	new	full	screen	
toggle	supplements	the	existing	menu	option	and	function	key	shortcuts	with	a	
button	that’s	suitable	for	both	touch	and	mouse	clicks.		
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Softube	Saturation	Knob	Update:	This	workhorse	ProChannel	module,	based	on	
Softube’s	FET	compressor	with	added	saturation,	has	been	updated	with	stability	
and	compatibility	improvements.	
		

	
Fixes	and	Enhancements:	The	bug-fixers	at	Cakewalk	went	on	a	bug-hunting	
frenzy	this	month,	and	nuked	a	bunch	of	those	rude	little	crittesr—including	the	
long-standing	“Why	does	stretching	an	audio	clip	sometimes	produce	an	
extraneous	snap	point?”	Well,	it	doesn’t	any	more.	

	
Charting	Now	in	SONAR	|	The	Top	10	Operating	Systems:	Amazingly,	some	people	
still	use	32-bit	Vista.	But	does	the	SONAR	community	march	in	step	with	the	rest	of	
the	world,	and	continue	holding	on	to	Windows	7?	Or	has	it	done	the	“fast	
forward”	to	Windows	10?	The	answer	might	surprise	you.		

	
Anatomy	of	a	SONAR	Project	|	A	Shootout	in	the	Wild	West	of	the	Industry:	Not	
only	has	the	record	business	changed,	so	has	doing	commercial	music.	Jimmy	
Landry	participates	in	a	shootout	to	create	the	music	for	an	upcoming	commercial,	
and	tells	what’s	involved	in	this	hyper-competitive	new	way	to	make	a	living.	

	
Scholarship	Opportunity	for	the	SONAR	Community:	From	time	to	time,	
composer/teacher	Jerry	Gerber—an	expert	SONAR	user—offers	a	free	scholarship	
to	a	deserving	student	who	want	to	improve	his	or	her	skills.	Want	to	up	your	
game?	Find	out	how	to	apply	in	this	article.	

	
Review	|	CME	Xkey	Air,	Where	MIDI	Meets	Bluetooth:	You	have	a	wireless	
keyboard	and	mouse,	a	wireless	internet	connection,	and	Apple	wants	to	convince	
you	to	wear	wireless	earbuds	and	ditch	the	1/8”	phone	jack.	But	can	MIDI	wireless	
deliver	low-latency,	reliable	operation?	Let’s	find	out.	

	
SurfBoard:	Surfing	the	internet	can	be	fun,	but	surfing	the	Cakewalk	forums	can	be	
downright	instructive	because	community	members	are	constantly	sharing	tips	and	
techniques.	We’ve	scoured	the	forums	for	the	latest	threads	that	can	help	you	get	
the	most	out	of	SONAR,	and	compiled	them	here.	
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How	to	Download	the	SONAR	2016.09	Update	
	
Open	the	Cakewalk	Command	Center.	If	you	don’t	have	the	latest	version	
(CakewalkCommandCenterSetup_1.1.7.1.exe),	please	download	it	from	the	Cakewalk	
Command	Center	home	page.		
	
To	download	the	SONAR	2016.09	core	update,	download	from	the	core	SONAR	Artist,	
Professional,	or	Platinum	category.	Platinum	members	should	also	download	the	latest	version	
of	the	Theme	Editor,	which	is	a	separate	program	and	appears	under	Connected	Products.	
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Plug-in	Load	Balancing	
Platinum	
	
SONAR’s	plug-In	load	balancing	exploits	the	full	power	of	multi-core	CPUs	to	balance	DSP	
workloads	across	multiple	cores	when	possible.	This	can	result	in	fewer	spikes	in	the	audio	
engine,	as	well	as	minimize	audio	dropouts	that	are	caused	by	unbalanced	processing	loads.	
	
To	enable/disable	plug-in	load	balancing,	choose	Edit	>	Preferences	>	Audio	-	Playback	and	
Recording.	Check	Use	Multiprocessing	Engine	(otherwise	plug-in	balancing	is	not	available),	
then	check	Plug-In	Load	Balancing.		
	

	
	
When	enabled,	SONAR	will	attempt	to	load	balance	track/bus/clip/ProChannel	FX	Racks,	FX	
Rack	FX	Chains,	and	ProChannel	FX	Chains	if	any	of	these	contain	two	or	more	unbypassed	plug-
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in	effects.	(However,	please	note	that	this	technology	does	not	benefit	virtual	instruments	in	
the	synth	rack,	FX	Racks	with	active	side	chains,	or	External	inserts.)	
	
WHEN	TO	USE,	OR	NOT	USE,	PLUG-IN	LOAD	BALANCING	
	
Load	balancing	uses	CPU	power	more	efficiently,	but	it	also	requires	some	CPU	power	because	
it	processes	the	plug-ins	at	smaller	buffer	sizes.	If	the	loads	aren’t	unbalanced	in	the	first	place,	
any	benefits	of	balancing	may	be	offset	by	the	extra	overhead.	So,	first	check	out	the	existing	
performance	status	with	the	new	Performance	Meter	modes	(described	in	the	next	eZine	
section).	Right-click	on	the	Performance	module,	choose	CPU	Meter	Display	Options,	then	
select	Audio	Processing	Load.	The	Performance	Meter	will	show	whether	the	load	on	the	CPU	
cores	is	balanced	or	not.		
	
Enable	plug-in	load	balancing	if:	
	

• There	is	CPU	spiking,	or	one	core	is	significantly	higher	than	the	others	
• The	project	uses	a	high	audio	latency	setting	
• One	track	performs	most	of	the	effects	processing	

	
Do	not	enable	plug-in	load	balancing	if:	
	

• The	CPU	load	is	evenly	distributed	(i.e.,	there	is	no	excessive	core	spiking,	and	no	
individual	core	works	significantly	more	than	the	others)	

• The	project	uses	many	lightweight	plug-ins	with	a	similar	load	
• All	tracks	use	about	the	same	number	of	effects,	or	have	a	similar	load	
• The	project	uses	a	Mixing	Latency	Buffer	Size	setting	under	256	samples	in	Edit	>	

Preferences	>	Audio	-	Driver	Settings	
	
For	information	about	how	plug-in	load	balancing	works,	as	well	as	“under	the	hood”	tweaks	
you	can	do	to	alter	the	smallest	internal	buffer	subdivision	used	for	plug-in	load	balancing	
(which	allows	for	more	aggressive	load	balancing),	please	see	the	online	help.	
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Expanded	CPU	Performance	Meter	Modes	
Artist,	Professional,	Platinum	
	
The	Control	Bar’s	Performance	meter	gives	information	on	your	system’s	resource	utilization,	
and	has	now	been	expanded	to	offer	three	different	monitoring	modes.	Among	other	
advantages,	the	Performance	meter	can	differentiate	between	how	much	resources	SONAR	is	
drawing	compared	to	the	system	as	a	whole.	This	can	alert	you	if	something	else	is	going	on	
that’s	taking	resources.		
	

The	three	Performance	Meter	modes	are:	
	
Audio	Processing.	This	default	mode	measures	SONAR’s	audio	processing	load,	and	represents	
the	ratio	of	the	actual	time	taken	to	process	a	buffer	compared	to	the	buffer	duration.	This	
helps	you	determine	if	you	need	to	increase	latency,	or	can	speed	operation	up	a	bit.	
System	Performance.	This	shows	the	global	system-wide	load	across	all	processor	cores,	as	
reported	by	the	operating	system	itself	(not	just	reporting	from	within	SONAR).	
Overall	App	Performance.	The	meter	shows	the	entire	SONAR	process	CPU	utilization	for	all	
processor	cores.	
	
To	choose	a	mode:	
	

1. Resize	the	Control	Bar	Performance	module	to	Large	or	Auto	if	needed	(the	CPU	meter	
must	be	visible),	then	right-click	anywhere	in	the	module.	

2. Point	to	CPU	Meter	Display	Options.	
3. Choose	the	desired	mode.	

	
The	tooltip	over	the	CPU	Meter	shows	the	selected	mode’s	name.	 	
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Quick	Group	Freeze	
Artist,	Professional,	Platinum	
	
Hot	on	the	heels	of	last	month’s	Quick	Group	FX	Insert,	
we’ve	answered	another	popular	feature	request	with	
Quick	Group	Freeze.		
	
Freeze	is	an	important	feature	when	you’re	running	out	of	
CPU	power	because	it	temporarily	bounces	tracks	that	
include	power-hungry	plug-ins	(like	virtual	instruments	and	
plug-ins)	to	audio,	which	requires	much	less	CPU	for	
playback.	Freezing	also	“disconnects”	the	original	track	to	
save	CPU	power	consumption,	but	you	can	also	
unfreeze/thaw	at	any	time	if	you	want	to	edit	the	plug-in	
parameters	or	make	other	changes.	
	
Previously,	tracks	had	to	be	frozen	one	at	a	time.	With	
Quick	Group	Freeze,	you	can	freeze	multiple	tracks	with	a	
single	gesture.	
	
1.	Select	the	tracks	you	want	to	freeze.	To	select	multiple	
tracks,	Ctrl+click	on	the	track	number	in	the	Track	or	
Console	view,	or	use	the	Smart	Swipe	feature	to	select	multiple	consecutive	tracks.	
2.	Hold	down	the	Ctrl	key,	then	click	the	Freeze	button	in	any	of	the	selected	tracks.	All	selected	
tracks	will	now	be	frozen.	
	
Similarly,	you	can	also	“thaw”	multiple	selected	tracks.	
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Full	Screen	Toggle	
Artist,	Professional,	Platinum	
	
Full	Screen	mode	hides	SONAR’s	title	bar	and	the	Windows	task	bar	so	that	SONAR’s	interface	
fills	the	entire	screen.	This	gives	more	“screen	real	estate”	for	working	within	SONAR.	
	
Another	advantage	of	full-screen	mode	is	that	you	can	leave	the	task	bar	locked	in	place	rather	
than	set	to	auto-hide,	which	occasionally	doesn’t	work	properly.	This	is	because	some	
applications	can	trigger	a	notification	that	keeps	the	taskbar	open,	but	doesn’t	provide	an	
obvious	way	to	close	the	notification.		
	
However	it’s	also	important	to	be	able	to	exit	full-screen	mode	quickly	if	you	want	to	use	the	
task	bar,	so	now	there	are	three	options.	
	
Menu:	Choose	Window	>	Full	Screen	
Keyboard	shortcut:	F11	
Touch	control	or	mouse	click:	The	new	Full	Screen	button	in	SONAR’s	top	right	corner	
	

	
	
Full	Screen	button	in	standard	mode	
	

	
	
Full	Screen	button	in	full	screen	mode	
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Softube	Saturation	Knob	Update	
Professional,	Platinum	
	

If	you’ve	overlooked	how	useful	the	ProChannel’s	Softube	
Saturation	Knob	can	be,	now	would	be	a	good	time	to	re-
visit	it—this	update	offers	improved	stability,	compatibility	
fixes,	and	streamlined	graphics.	It	also	complements	the	
ProChannel	Tube	distortion	module	well.	
	
The	key	to	getting	the	most	out	of	the	Saturation	Knob	is	
selecting	the	proper	mode	(Keep	High,	Neutral,	and	Keep	
Low).	For	example,	Keep	High	doesn’t	distort	the	high	
frequencies,	so	for	lo-fi	drums	the	cymbals	won’t	be	as	
distorted	as	the	rest	of	the	drum	kit,	which	gives	more	
“body.”	However	if	you	want	to	retain	the	kick	drum’s	tone	
and	level,	then	you	would	choose	Keep	Low,	which	avoids	
distorting	low	frequencies.	
	
As	to	using	the	Saturation	Knob	and	Tube	module	
together,	each	has	a	different	character,	and	driving	one	
with	the	other	can	give	sounds	you	can’t	get	with	either	
one	by	itself—and	switching	their	order	gives	yet	another	
set	of	timbres.	You	can	also	enhance	saturation	by	the	
modules	you	put	before	and	after	saturation,	like	inserting	
the	S-Type	Channel	compressor	first,	then	Cakewalk’s	Tube	

distortion,	and	finally	the	Saturation	knob.	Driving	the	Saturation	Knob	with	Tube	produces	a	
wider	variety	of	distortion	effects	than	the	reverse	order.	Finally,	follow	the	Saturation	knob	
with	EQ	to	shape	the	saturated	sound.		
	
For	an	example	with	bass,	start	with	all	modules	bypassed.	Adjust	the	tone	to	taste,	then	
enable	the	compressor	and	dial	some	dynamics	processing	for	a	“rounder”	sound.	Enable	Tube	
in	Type	1	mode	and	turn	up	the	Input	and	Drive	controls	for	an	amp-type	growl.	Next,	enable	
the	Saturation	Knob;	select	“Keep	High”	to	give	a	fuzz	bass	sound,	“Neutral”	for	a	more	
aggressive	version	of	the	tube	distortion,	or	“Keep	Low”	to	change	the	tone	and	give	a	more	
sustained	distortion.	You	can	then	use	the	QuadCurve	EQ	to	emulate	a	cabinet	effect—enable	
the	Low	Pass	filter	to	trim	the	highs,	bring	the	midrange	down	a	bit	around	1.5	kHz	to	
emphasize	the	bass,	and	then	add	a	broad,	low	bass	bump	for	a	rounder	tone.	
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This	combination	of	compression,	distortion,	and	EQ	will	give	the	bass	more	authority	and	grit,	
and	stand	out	in	a	bit	more	in	mixes.	The	Saturation	Knob	is	even	useful	as	a	Send	effect	when	
you	want	to	add	a	little	bit	of	dirt	to	multiple	tracks.	 	
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Fixes	and	Enhancements	
	
This	month’s	update	fixes	the	following	issues	in	multiple	categories:	
	
TAKE	MANAGEMENT/COMPING	
	

• It	was	not	possible	to	drag	a	clip	to	a	different	lane	in	another	track	if	the	target	track	
was	below	the	source	track	

• Speed	Comping	could	create	unexpected	extra	clips	
• In	some	cases,	Speed	Comping	would	fail	to	mute/unmute	clips	
• Paste	of	clip	always	ended	up	on	Take	Lane	original	to	source	clip	
• Dragging	a	comp	clip	to	a	Take	Lane	produced	unexpected	results	
• In	some	cases,	attempting	to	cross-crop	two	adjacent	clips	in	different	lanes	would	

affect	only	a	single	clip	
	
PLUG-INS	
	

• Various	VST	3	Host	Bypass	fixes	
• Plug-in	upsampling	did	not	operate	properly	in	some	cases	
• Quick-Group	insert	FX	could	fail	if	the	selected	tracks	contained	different	numbers	of	

plug-ins	
• Customizing	FX	Chains	could	cause	SONAR	to	hang	
• FX	Chains	could	cause	crash	when	used	in	a	playlist	
• Changing	VST3	presets	from	the	plug-in	property	page	sometimes	resulted	in	

inconsistent	behavior	
• Assignable	controls	for	Waves	plug-ins	could	send	to	incorrect	parameter	

	
REGION	FX	
	

• Pro	Channel	would	disappear	on	all	tracks/buses	after	Melodyne	bounce-to-clips	when	
followed	by	right-clicking	another	clip.	

• Undo	of	a	copied	Melodyne	clip	did	not	update	the	Melodyne	GUI	
• Deleted	tracks	that	contained	Melodyne	Region	FX	clips	were	still	displayed	in	

Melodyne's	track	header	
	
BROWSER	
	

• Crash	on	startup	related	to	SQLLite	
• The	Plug-in	Browser	could	display	empty	category	folders	
• The	Plug-in	Browser	could	display	an	empty	"Uncategorized"	folder	in	the	Instruments	

tab	
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• SONAR	could	crash	upon	launch	if	the	Plug-in	Browser	library	database	was	corrupt	
• In	the	Plug-in	Browser,	it	was	not	possible	to	revert	DirectX	Plug-ins	to	their	original	

name	
• Renaming/categorizing	plug-ins	in	the	Plug-in	Browser	would	close	all	expanded	folders	
• Renaming/categorizing	plug-ins	in	the	Plug-in	Browser	could	result	in	temporary	freeze	

if	performed	on	Windows	Basic/Classic	theme	
• Changing	friendly	plug-in	name	did	not	initially	update	existing	instances	in	FX	Racks	
• The	Plug-in	Browser	did	not	hide	folders	for	VST2s	with	identical	plug-in	names	
• Cakewalk	TTS-1	did	not	display	a	friendly	name	in	the	Set	Categories	dialog	box	
• Plug-in	Browser	category	was	named	"General	Midi"	instead	of	"General	MIDI"	
• When	not	showing	plug-in	categories,	the	Plug-in	Browser	would	create	a	new	folder	for	

any	loose	VST3	plug-ins	that	were	installed	in	the	Common	Files\VST3	root	folder	
• Closing	a	project	with	the	Synth	Rack	open	could	result	in	a	crash	
• Insert	Synth	menu	would	fail	to	open	if	there	were	more	than	255	VSTi	plug-ins	available	

	
MATRIX	
	

• Matrix	could	skip	first	note	in	MIDI	clips	when	playback	started.	
• It	was	not	possible	to	scroll	in	the	Matrix	with	the	mouse	wheel	if	the	mouse	was	over	

track	strips.	
• Undoing	a	Matrix	performance	recording	could	result	in	a	crash.	

	
PROCHANNEL	
	

• Saturation	Knob	could	cause	SONAR	to	crash.	
	
MISCELLANEOUS	
	

• Selecting	the	last	Automation	Lane	could	cause	a	crash	
• It	was	not	possible	to	rename	bus	Automation	Lanes	
• It	was	not	possible	to	use	the	Crop	tool	on	the	right	side	of	a	crossfade	unless	you	

selected	the	clip	
• Selecting	the	left	clip	in	a	crossfade	would	obscure	the	right	clip's	fade	in	
• Cropping	multiple	clips	simultaneously	would	fail	in	some	case	when	Snap	to	Grid	was	

enabled	
• Adjusting	crossfade	on	multiple	selected	tracks	did	not	produce	correct	results	
• Auto	Crossfades	did	not	work	properly	with	clip	selection	groups	
• 'Select	Track	Envelopes	with	Clips'	did	not	function	properly	when	moving	grouped	clips	
• Modified	clip	colors	in	the	Inspector	didn't	show	immediately	
• Unexpected	behavior	when	adjusting	clip	length	from	the	Clip	Properties	inspector	if	the	

format	was	MBT	
• Superfluous	snap	offset	was	created	after	stretching	audio	clip	
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• Scroll	bar	thumb	was	difficult	to	see	while	being	dragged	
• Clicking	rapidly	in	the	scroll	bar	did	not	always	advance	the	timeline	
• Under	rare	circumstances,	a	crash	could	occur	when	deleting	buses	
• “Follow	Host	Tempo”	did	not	behave	as	expected	
• The	About	screen	showed	mixed	version	information	
• General	Installer	improvements	

	
HELP	
	

• Help	Module	would	not	show	text	for	the	time	ruler	or	Clips	pane	
• Help	button	for	Preferences	>	File	-	Audio	Data	did	not	open	help	topic	
• Help	button	for	Preferences	>	Project	-	Surround	did	not	open	help	topic	

	
LOCALIZATION	
	

• Multiple	Brazilian-Portuguese	UI	fixes	(applies	to	Steam	users	of	SONAR	Brazilian	
Portuguese	2016.08)	

• [Russian]	Several	list	items	in	Edit	>	Preferences	>	Customization	-	Colors	were	cut	off	
• [Russian]	Some	values	in	the	Groove	Quantize	dialog	box	were	cut	off	
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Charting	Now	in	SONAR:		
The	Top	10	Operating	Systems	
	
	
In	the	wide,	wide	world	of	Windows,	despite	
Microsoft	hoping	to	get	everyone	on	the	Windows	10	
bandwagon,	there	are	still	quite	a	few	different	
operating	systems	in	use.	But	which	one	is	most	
popular	among	SONARians?	We	asked	Analytics	to	tell	
us	which	operating	systems	get	used	for	the	greatest	
number	of	sessions,	and	what	we	found	was	that	the	
heaviest	SONAR	users	place	a	premium	on	64-bit	
operation	and	high	performance.	
	
#1:	Windows	10	–	64	Bit	
With	an	almost	3:1	lead	over	second	place,	SONAR	users	are	voting	with	their	wallets	and	going	
for	Windows	10.	Although	actually,	it’s	probably	more	accurate	to	say	they’re	not	voting	with	
their	wallets	because	they	likely	installed	Windows	10	when	it	was	a	free	upgrade…but	you	get	
the	point.	In	any	event,	this	may	also	help	explain	the	general	consensus	about	SONAR	
performing	very	well—it	seems	SONAR	and	Windows	10	were	made	for	each	other.		
	
#2:	Windows	7	–	64	Bit	
Then	there	are	those	who	subscribe	to	“if	it	ain’t	broke,	don’t	fix	it”	and	have	remained	loyal	to	
Windows	7,	an	operating	system	that’s	seven	years	old	but	is	also	a	real	workhorse.	Looks	like	
SONAR	support	for	Windows	7	probably	won’t	be	going	away	any	time	soon.	
	
#3:	Windows	8.1	–	64	bit	
Well	it’s	almost	as	good	as	Windows	10…and	certainly	an	improvement	over	the	ill-fated	
Windows	8,	which	even	Microsoft	urged	people	to	avoid	using	not	too	long	after	it	was	
introduced.	Fortunately	drivers	that	work	with	Windows	8.1	tend	to	work	well	with	Windows	
10,	so	upgrading	is	pretty	painless.	
	
#4:	Windows	7	–	32	bit		
Given	how	long	SONAR	has	been	64-bit	friendly,	it’s	probably	not	surprising	that	the	
overwhelming	majority	of	SONAR	users	embrace	64-bit	operating	systems.	But	when	it	comes	
to	32-bit	operating	systems,	“old	faithful”	Windows	7	holds	the	top	slot.	And	why	not?	It	still	
works.	
		
#5:	Windows	10	–	32	bit		
Unlike	64-bit	operating	systems,	with	32-bit	operating	systems	the	results	are	flipped:	more	
Windows	7	than	Windows	10	users.	If	you’re	going	to	hold	on	to	a	frozen	system	because	it	
works	the	way	you	want,	might	as	well	keep	it	at	32	bits.	
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#6:	Windows	8	–	64	bit	
Frankly,	this	result	is	somewhat	puzzling.	Microsoft	ended	official	support	for	Windows	8	early	
this	year—so	there	are	no	more	security	patches	or	crucial	updates	unless	you	update	to	
Windows	8.1	(which	is	free)	or	Windows	10.	Seriously	folks,	consider	updating…	
	
#7:	Windows	8.1	–	32	bit	
This	is	definitely	a	better	choice	than	Windows	8,	but	there’s	still	a	lot	to	be	said	for	going	64	
bits	when	it’s	time	for	a	new	machine.	
	
#8:	Windows	8	–	32	bit	
There’s	a	rapid	dropoff	in	session	count	from	32-bit	Windows	8.1	to	32-bit	Windows	8,	but	the	
same	comment	applies:	you	really	need	to	update	to	8.1.	Everything	should	still	work	as	
expected,	and	you’ll	be	able	to	receive	ongoing	mainstream	support	until	January	9,	2018	(with	
extended	support	until	January	10,	2023).	
	
#9:	Windows	Vista	–	32	bit	
And	now,	the	hardy	holdouts:	32-bit	Windows	Vista	represents	a	minuscule	0.0001%	of	the	
total	session	count.(	Then	again	if	I	was	running	32-bit	Vista,	I	too	would	probably	be	
discouraged	from	using	it	very	much.)			
	
#10:	Windows	Vista	–	64	bit	
Vista	got	a	really	bad	rap	for	a	variety	of	reasons,	but	the	reality	is	that	by	the	time	you	finished	
doing	all	the	updates,	it	had	essentially	become	Windows	7.	However,	as	a	10-year-old	
operating	system,	it’s	far	from	cutting	edge.	Too	bad	the	free	update	to	Windows	10	wasn’t	
available	for	Vista,	whose	mainstream	support	ended	over	four	years	ago.	
	
Conclusions	
These	stats	make	it	clear	that	SONAR	users	are	big-time	fans	of	64-bit	computers.	Also,	66%	of	
all	SONAR	sessions	are	done	with	64-bit	Windows	10.	For	comparison,	in	the	overall	world	of	
computers	Windows	10	has	about	23%	overall	OS	market	share,	while	Windows	7	still	
dominates	at	47%	(as	of	August	Mac	OS	X	10.11	has	4.38%,	Linux	2.1%,	and	Windows	8.1	8%).	
	
Remember,	though,	that	these	stats	aren’t	based	on	which	OS	is	installed,	but	which	OS	is	used	
for	the	greatest	number	of	sessions.	So	while	the	total	universe	of	SONAR	users	may	not	be	on	
Windows	10	yet,	the	ones	who	are	the	most	active,	and	do	the	most	work	with	SONAR,	clearly	
favor	the	most	recent	and	highest-performance	options.	
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Anatomy	of	a	SONAR	Project:	A	Shootout	in	the	Wild	West	of	an	
Industry	
	
By	Jimmy	Landry	
	
Everyone	knows	the	music	industry	has	changed	drastically	in	the	last	decade.	From	record	
companies	taking	a	back	seat,	to	100k+-seat-venues	being	sold	out	at	astronomical	ticket	prices	
for	“electronic	experiences,”	just	about	every	facet	of	the	business	is	no	longer	“same	as	it	ever	
was.”	And	the	commercial	side	of	music	creation	has	changed	as	well.	Not	too	long	ago,	I’d	get	
lucky	once	in	a	while	when	my	phone	rang,	and	my	manager	said	“Company	X”	wanted	a	piece	
of	music	for	something	by	the	end	of	the	week.	Depending	on	what	they	wanted,	this	“work	for	
hire”	could	pull	in	a	cool	$5k	–	$10k	plus	residuals	for	way	less	than	a	week’s	work.	
	

As	we	fast	forward	to	2016	with	the	home-
studio	DAW	revolution,	we	now	have	what	
the	commercial	music	industry	calls	a	
“shootout.”	From	agents,	to	music	
supervisors,	post	houses,	song	pluggers	and	
just	about	anyone	else	in	between	who	has	
relationships	to	get	their	hands	on	a	hot,	
time-sensitive	“creative	brief,”	many	
composers/producers	are	now	working	on	
a	“shootout”	basis.	Here’s	what	that	
means.	
	

As	in	the	past,	companies	who	use	video	advertisements	for	their	goods	and	services	often	do	
not	have	the	capacity	to	put	together	a	full	sync	production.	These	companies	use	creative	
companies	such	as	The	Music	Playground	or	Butter	Music	to	execute	their	message.	The	client	
works	closely	with	a	company’s	team	to	put	together	a	“creative	brief.”	This	is	the	instrument	
that	converts	the	advertisement’s	overall	message	from	the	executives	into	musician’s	terms.	
Once	created,	the	creative	team	then	moves	forward	to	generate	the	music	and	sound	for	the	
advertisement	using	its	pool	of	composers,	producers,	and	musicians.		
	
A	common	method	(or	flow	if	you	will)	nowadays	is	for	a	trusted	composer	or	producer	to	be	
on	a	list	of	one	of	these	creative	companies.	When	the	creative	company	has	a	job,	it	will	then	
reach	out	to	several	suitable	composers	who	work	in	a	style	that	matches	the	goal	of	the	
creative	brief	to	start	the	shootout	process.	Sometimes,	there’s	a	small	honorarium	for	each	
producer/composer	selected	for	the	shootout	process,	and	then	if/when	their	submission	is	
chosen	by	the	advertising	company	they	will	then	win	the	“purse.”	These	purses	range	greatly	
in	price	these	days;	they	can	still	be	worth	up	to	$15k	or	$20k,	but	a	more	common	range	is	
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$2.5k	–	$5k.	There	can	also	be	residual	income	from	intellectual	property	on	these	with	AFM	
(American	Federation	of	Musicians),	SAG	(Screen	Actors	Guild),	and	PRO	(Performing	Rights	
Organization)	collection,	depending	on	the	contractual	agreements.	
	
So	in	this	web	of	shootouts,	not	only	can	a	
composer/producer	get	a	call	from	a	creative	
agency,	but	work	can	also	come	in	from	other	
musicians	as	in	the	case	of	this	Anatomy	of	a	
SONAR	Project.	Recently	I	received	an	email	
from	my	friend,	industry	colleague	and	
neighbor	Jody	Redhage	who	currently	is	one	of	
the	most	sought-after	cellists	in	the	industry.	
She	has	been	in	Esperanza	Spalding’s	band,	
toured	all	over	the	world,	and	has	played	
some	very	high-profile	venues	including	The	
Tonight	Show,	Carnegie	Hall,	Lincoln	Center,	
Radio	City	Music	Hall	and	the	Hollywood	Bowl	
just	to	name	a	few.	As	a	composer,	she	is	
plugged	into	some	creative	agencies	similar	to	
my	network,	and	we	sometimes	work	on	
projects	together.	
	
For	this	shootout,	we	got	the	creative	brief	from	an	agency	that	was	working	with	a	car	
company	on	a	new	internet-only	video	to	air	during	the	winter.	Creative	briefs	vary,	but	in	the	
case,	the	client	had	a	very	specific	vibe	in	mind.	They’d	been	hoping	to	use	Talking	Heads’	
“Road	to	Nowhere,”	but	David	Byrne	doesn’t	license	to	commercials	so	they	needed	original	
music.	
	
The	creative	brief	had	several	requirements:	
	

• Hitting	a	deadline	(and	of	course,	it’s	always	sooner	than	you’d	like)	
• An	organic,	intimate,	human	quality	with	a	single	male	vocal.	
• Lyrics	that	conveyed	a	particular	sense	of	traveling	for	the	sake	of	same,	without	a	

particular	destination.	
• A	“people	making	music	in	a	room”	vibe—no	four-on-the-floor	overdone	clap-folk	

music,	and	if	any	orchestral	elements	were	used,	they	had	to	feel	modern.		
• The	track	needed	to	have	personality	and	make	a	creative	statement,	not	sound	like	

“math	homework.”	
	
So	within	those	parameters,	it	was	time	to	start	writing	and	recording.	
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WRITING	AND	SKETCH	
	
So	away	we	went,	and	I	knew	the	most	important	aspect	for	me	was	to	keep	it	simple.	
Sometimes	SONAR	makes	things	so	easy	to	produce,	one	can	get	a	bit	carried	away.		
	
The	first	and	most	important	focus	was	on	the	piece’s	lyrical	direction	and	melody.	The	imagery	
of	the	spot	was	amazing	and	really	quite	fun	to	write	music	to.	I	had	a	few	simple	chord	
progressions	with	melodies	that	I	ran	by	Jody,	and	let	her	pick	the	one	to	develop…which	is	the	
beauty	of	working	on	a	project	with	someone	who	has	a	great	musical	sense.	
	
After	a	few	hours	we	had	the	backbone	of	a	decent	track	by	just	having	one	mic	up	in	the	room	
for	demo	purposes.	I’ve	been	around	the	block	a	few	times	with	this	type	of	shootout,	winning	
some	and	losing	some,	so	I	knew	that	the	key	to	this	type	of	project	was	going	to	be	making	it	
sound	like	a	real	“song”	and	not	a	commercial	“spot.”	This	meant	I	had	to	learn	the	vocal	
performance	so	well	so	that	it	would	feel	like	a	real	song	when	recording.	So,	I	called	it	a	night	
so	that	I	could	actually	practice	what	we	came	up	with	vocally,	and	also	organize	the	SONAR	
project	a	bit.	I	also	spent	some	time	planning	on	how	I	would	track	this	piece,	which	was	a	bit	
unorthodox	in	the	instrumentational	sequence…keep	reading.	
	
TRACKING	CELLO	
	
The	next	night	we	started	in	on	the	tracking,	and	I	decided	to	try	
something	different	than	my	normal	track	development	routine.	
Because	the	agency	was	calling	for	a	more	organic	type	of	song,	I	
fought	every	tendency	I	had	to	use	a	click	track	and	ended	up	tracking	
freely.		Jody	Redhage	is	a	machine	with	timing	and	we	actually	ended	
up	cutting	the	cello	as	the	backbone	track	to	the	song—indeed	
unorthodox,	but	I	had	a	plan	working	backwards.	I’d	tracked	Jody	in	
the	past	here	in	my	room,	so	I	knew	the	setup	on	how	to	get	a	great	
sound.	For	capturing	the	low	end	I	used	a	Neat	King	Bee	mic	(which	
really	does	a	great	job	getting	full	sounds	below	300	Hz)	through	a	
Yamaha	PM1000	preamp	(a	lucky	find	out	of	Nashville,	racked	up	as	a	
stereo	pair).	Up	near	where	the	bow	strikes	the	strings,	I	used	an	
AT4033a	through	a	Neve	1073	knockoff	made	by	Golden	Age.		
	
ACOUSTIC	GUITAR	
	
Next	up	was	the	acoustic	guitar	tracking,	which	involved	doubling	the	parts	L/R	using	my	ADK	
Hamburg	and	Vienna	mics	through	a	Rane	Mb1	preamp	on	one	side,	and	a	TASCAM	UH7000	
preamp	on	the	other.	Since	this	track	wasn’t	very	complicated,	I	was	able	to	think	through	
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some	techniques	before	getting	to	the	mix.	I	had	one	mic	super	close	during	take	1	on	the	12th	
fret,	and	then	with	take	2	moved	the	mic	12	inches	away.	This	created	some	“depth”	for	the	
mixing	process.	
	

BASS	
	
The	bass	tracking	came	next,	which	took	three	minutes.	I	
went	direct	into	the	PM1000’s	instrument	input	with	a	
Tobias	bass,	and	kept	the	lines	really	simple.	After	tracking,	
Overloud’s	TH3	amp	sim	was	ideal	for	dialing	in	the	bass	
sound	with	the	rest	of	the	very	acoustic	tracks.	
	
PERCUSSION	WITH	ADDICTIVE	DRUMS	2	
	
Now	it	was	time	to	dive	into	SONAR’s	Addictive	Drums	2	
kits	to	execute	part	of	the	master	plan	with	this	
track…finger	drums!	Yes	indeed;	because	the	track	was	30	
seconds	long,	we	didn’t	track	to	a	click	track,	and	drum	
simplicity	was	to	be	a	key	component,	using	controller	
“freestyle”	for	drum	parts	worked	out	perfectly.	After	
going	through	the	track	about	five	times	I	had	all	the	minor	

nuances	in	my	head,	and	could	conform	the	timing	to	the	track.	I	ended	up	in	SONAR’s	Piano	
Roll	View	after	the	take	to	shift	a	few	notes	around	by	ear,	but	the	final	result	sounded	decent	
and	had	a	good	vibe.	
	
VOCALS	
	
Now	with	the	base	of	
the	song	tracked,	it	
was	time	to	move	on	
to	vocals	before	laying	
down	the	final	
colorings.	I	often	prefer	
this	approach	with	my	
style	of	writing,	
because	it	allows	room	
for	the	vocal	melody	inflections	before	the	track	gets	too	busy.	It	also	allows	for	final	color	to	be	
added	as	an	embellishment	to	the	vocals,	which	are	most	important	to	a	listener’s	ear.	The	
great	thing	about	SONAR	with	these	types	of	projects	is	that	it’s	so	easy	to	organize	workflow.	
At	this	point	in	the	process,	everything	went	neatly	into	track	folders	so	that	I	wasn’t	
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overwhelmed	with	track	counts.	I	even	have	track	folders	for	the	scratch	tracks,	which	makes	it	
easy	to	go	back	and	find	parts	as	originally	written.	
	
COLOR	
	
After	I	quickly	tracked,	comped,	and	edited	my	vocals	using	an	Advantone	through	a	Golden	
Age	Pre73,	I	started	working	on	some	different	ideas	to	add	counterpart	to	the	song.	There	was	
a	lot	going	on	between	80	Hz	–	500	Hz,	so	I	threw	a	capo	on	my	Les	Paul’s	5th	fret,	which	really	
did	the	trick:	using	the	guitar’s	upper	register	with	some	open	chords	created	a	nifty	vibe	that	
had	been	lacking.	Keeping	true	to	the	organic	request,	I	kept	the	tone	pretty	clean	except	for	
some	spring	reverb	and	tape	delay	to	sweeten	the	sounds.	(By	the	way,	upgrading	to	TH3	from	
TH3	SONAR	is	well	worth	the	price.	I’ve	A/B’d	a	lot	of	guitar	simulators,	and	TH3	is	one	of	the	
few	that	stays	big	in	the	mix	when	surrounded	by	big	tracks.)	
	
MIXING	AND	MASTERING	
	
This	mix	was	pretty	easy	since	I’d	kept	the	
tracking	to	a	minimum.	As	always,	the	
percussion	tracks	came	first.	Thanks	to	
SONAR’s	Track	Templates	the	drums	were	
already	routed	to	separate	tracks,	sent	
through	buses,	and	ready	for	any	final	
treatment.	Using	David	Bendeth’s	DB+10	
plug-in	on	a	parallel	compression	bus	gave	
more	depth	to	the	kit	as	a	whole.	I	also	
brightened	up	each	track	individually	with	
the	Quadcurve	EQ,	and	alleviated	some	
trouble	frequencies	with	a	few	tom	hits.	
	
The	bass	didn’t	really	need	much	help	
besides	some	gentle	compression	and	
EQ’ing	to	mesh	with	the	tom	hits.	Since	the	bass	part	itself	was	more	or	less	of	a	wash	just	to	
add	some	low	end,	there	was	no	concern	about	a	“bass	part”	fitting	in.	The	acoustic	guitars	
needed	some	help	as	they	usually	do—particularly	some	low-mid	frequencies	that	needed	
notching.	I	also	added	the	Waves	“Maserati	Acoustic”	plug-in	to	each	acoustic	guitar	track,	
which	gave	a	“woodier,”	brighter	tone.	I’m	not	afraid	of	presets	with	the	Waves	plug-ins;	
they’ve	done	an	amazing	job	of	providing	great	“points	of	departure.”	
	
The	cello	and	acoustic	guitar	parts	were	next.	The	close	mic	for	the	acoustic	guitar	was	panned	
about	65%	on	the	left,	and	the	far	mic	on	the	right	at	100%.	I	implemented	the	same	
orientation	for	the	cello,	with	the	bow	mic	on	the	right	at	65%	and	the	Neat	(low	end,	and	EQ’d	
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to	fit)	mic	on	the	left.	This	panning	strategy	gave	an	even,	full	range	of	acoustic	instrumentation	
with	great	ambience	on	the	outside	of	the	spectrum.	These	tracks	were	then	sent	to	a	master	
acoustic	bus	for	further	minimal	treatment	with	more	EQ	and	light	compression.	
	

The	FX	Chains	presets	in	
SONAR	are	a	life	saver	for	
projects	like	this	because	
you’re	able	to	dial	in	
effects	so	quickly.	I	have	
about	20	different	chains	
for	vocals	that	I’ve	used	
when	doing	these	
shootouts.	The	chain	for	
this	one	includes	the	
waves	Rvox,	Cakewalk’s	
CA-2A,	the	PSP	McQ,	and	
the	Waves	DeEsser.	
Through	this	chain	my	
vocals	sat	well	in	the	mix	
almost	immediately.	On	
the	final	mix	(as	you’ll	
read	below),	I	used	a	
track	where	Jody	sang	
way	in	the	back	and	right	

in	the	middle,	with	a	good	amount	of	Breverb	and	a	mono	delay.	This	gave	the	track	a	whole	
new	“campfire”	vibe,	but	was	also	inconspicuous	enough	that	it	didn’t	get	in	the	way.	
	
Mastering	isn’t	very	important	at	this	stage.	I	mix	thinking	that	the	master	is	just	going	to	be	
louder,	because	at	the	end	of	the	day	if	this	track	was	selected,	I	would	be	delivering	a	
mastered	and	non-mastered	version.	For	this	track	I	used	Cakewalk’s	new	Linear	Phase	plug-ins,	
and	then	upped	the	volume	through	the	T-Racks	“Classic”	plug-in	using	the	Softclipper.	
	
DELIVERY,	REVISIONS,	RESULTS	
	
After	uploading	the	files	to	the	agent’s	folder	(yes,	we	made	the	deadline),	we	received	
feedback	in	less	than	four	hours.	The	agency	had	already	been	in	contact	with	the	marketing	
executives	and	as	always,	they	were	very	blunt	with	their	feedback:	
	

1. Love	the	vibe	of	the	track	–	nailed	the	overall	feel.	
2. Love	the	mix	and	production.	
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3. Love	lyrics	are	dead-on.	
4. Vocal	part	does	not	fit	the	desired	message.	It	overtakes	the	piece	and	is	too	much	for	

what	they	want.	It	also	seems	too	“rock”	oriented	and	needs	more	“campfire.”	Can	you	
revise	the	vocal	melody	and	resubmit?	

5. This	track	could	be	considered	if	the	vocals	had	a	different	approach.	
6. If	revised,	it	would	need	to	be	submitted	by	noon	(tomorrow	PST).	

	
So	it	was	back	to	the	drawing	board	with	the	vocals.	Because	the	track	was	completed,	the	
main	task	was	to	pick	my	acoustic	back	up	and	grind	away	at	the	melody.	Jody	came	back	at	10	
PM,	we	worked	out	a	few	ideas,	and	began	tracking.	This	is	another	strong	SONAR	asset,	and	
why	I	think	so	many	commercial	composers	use	the	program:	revisions	are	a	snap.	I	was	able	to	
track	a	few	new	vocal	melodies,	and	Jody	sang	unison	an	octave	higher	on	the	track	to	give	it	
that	“campfire”	vibe	they	referenced.	I	buttoned	up	the	two	versions	and	sent	them	off	around	
1	AM	to	the	agency.	
	
About	12	hours	later	we	received	an	email	acknowledging	the	tracks	were	received,	and	we’d	
be	informed	if	instrumental	and	acapella	versions	needed	to	be	cut.	At	this	point	of	the	journey,	
as	usual	it	was	just	a	waiting	game…12	hours…24	hours…36	hours—is	no	news	good	news?		
	
Finally,	about	3+	days	after	starting	the	project	we	received	an	email	with	the	verdict.	It	read	
similarly	to	those	emails	you	get	after	a	job	interview	when	they	select	another	candidate…	
	
With	all	that	said,	getting	shot	down	in	a	shootout	is	really	not	a	bad	thing	and	far	from	a	waste	
of	time.	Here	are	some	positive	takeaways	I	learned	from	this	specific	shootout	for	anyone	
going	down	this	road	in	the	future:	
	

• 300	bucks	is	300	bucks	☺	(the	honorarium	paid	for	this	submission;	the	agency	does	not	
own	the	master	or	underlying	composition).	

• Anytime	you	get	to	a	second	round	with	an	agency,	you	know	they’ll	circle	back	to	you	
in	the	future	for	more	projects.	

• Jody	will	certainly	ring	my	cell	again	on	projects	like	this.	
• We	now	have	a	good	30-second	spot	that	could	fit	into	another	campaign	someday—or	

it	can	easily	be	turned	into	a	full	song	to	be	released.	
	
And	now	we’re	ready	for	the	next	one!	You	can	listen	to	the	reference	track	here.	
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Scholarship	Opportunity	for	the	SONAR	Community	
	
Composer	Jerry	Gerber	is	a	long-time	SONAR	user	and	community	member;	we	covered	his	
latest	recording	Virtual	Harmonics	in	the	“Anatomy	of	a	SONAR	Project”	feature	(February	
2016/”Newburyport”	Cakewalk	eZine).	However	he’s	also	a	well-known	teacher	who	from	time	
to	time,	offers	scholarships	to	serious	students	whose	potential	could	be	further	realized	with	
more	knowledge	and	training.	
	
Jerry	is	offering	three	months	of	weekly	instruction	to	a	young	(under	35)	composer	who	is	
passionate	about	music	composition	and	production.	Although	there	is	no	charge,	candidates	
must	meet	certain	qualifications	to	be	considered.		
	

• Must	play	a	traditional	musical	instrument	(not,	for	example,	an	iPad)	
• Can	read	music	
• Has	experience	composing	and	producing	music	
• Musical	interests	must	include	classical	music	

	
Ideally,	being	local	to	the	San	Francisco	Bay	Area	would	allow	for	personal	interaction.	However	
Jerry	has	a	lot	of	teaching	experience	using	Google	Hangouts,	so	candidates	from	anywhere	in	
the	world	are	eligible.	Depending	on	the	student’s	needs,	the	focus	can	be	on	
composition/MIDI	orchestration,	or	production	issues	including	sequencing,	mixing,	signal	flow	
and	software	synthesis,	as	well	as	an	introduction	to	tonal	counterpoint	or	classical	harmony.	
One	reason	he’s	approaching	this	community	is	because	SONAR	users	will	be	able	to	benefit	
from	his	many	years	of	working	with	the	program.		
	
If	you’d	like	to	be	considered	for	this	unique	opportunity,	please	email	Jerry	directly	at	
jerry@jerrygerber.com.	For	more	information	about	his	teaching	practice,	background,	and	
areas	of	expertise,	please	visit	www.jerrygerber.com/teaching.htm	
	
	

Jerry	Gerber	has	written	orchestral	and	chamber	music,	songs,	
piano	music,	vocal	music	and	music	for	electronic	instruments.	He	
received	his	Bachelor	of	Music	in	composition	and	classical	music	
theory	from	San	Francisco	State	University	in	1982	and	has	
composed	for	film,	television,	computer	games,	concerts,	dance	
and	interactive	media.	His	latest	recording,	Virtual	Harmonics,	
was	recorded	using	SONAR	and	a	variety	of	virtual	instruments.	
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Review:	CME	Xkey	Air,	Where	MIDI	Meets	Bluetooth	
	
By	Craig	Anderton	
	
The	Everett	release	eZine	reviewed	the	CME	Xkey	25,	a	thin-profile	mobile	keyboard	with	
(among	other	features)	polyphonic	aftertouch.	Now	we	have	25-	and	37-key	versions	of	the	
Xkey	Air	($199	and	$299	respectively),	which	transmit	MIDI	wirelessly	via	Bluetooth	Low	Energy	
(BLE)	and	also	serve	as	traditional	USB	keyboards.	Physically,	the	new	keyboards	are	very	
similar	to	the	original	models,	so	please	check	out	the	original	review	for	background.	
	

	
The	25-key	Xkey	Air	

	
The	idea	of	wireless	is	appealing—I’d	love	wireless	headphones	when	doing	overdubs!	I	didn’t	
really	think	about	how	much	cables	get	in	the	way	until	I	bought	a	wireless	keyboard	and	
mouse,	and	now	I	wouldn’t	mind	more	options.	Although	(at	least	for	now)	Bluetooth	isn’t	
really	suitable	for	studio-quality	audio,	it	can	handle	MIDI’s	relaxed	bandwidth	requirements	
easily.	
	
Meet	Bluetooth	Low	Energy.	Reliance	on	BLE	is	both	the	good	news,	and	the	bad	news.	The	
good	news	is	that	it’s	faster	and	more	efficient	than	standard	Bluetooth.	The	bad	news	is	that	
it’s	available	on	only	the	most	modern	hardware,	and	sometimes	not	even	that.	I	tried	the	Xkey	
Air	(37-note	model)	on	a	mid-2012	MacBook	Pro	running	El	Capitan,	a	circa	2013	HP	laptop	with	
Windows	10	Anniversary	Edition,	a	pre-Lightning	iPad,	an	Intel	NUC	(also	running	Windows	10	
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Anniversary	Edition),	as	well	as	my	venerable	PC	Audio	Labs	desktop	computer.	None	of	them	
recognized	the	Xkey	Air	as	a	Bluetooth	device,	nor	was	pairing	possible.	
	

The	good	news	is	that	you	can	get	the	$49	“WIDI	BUD”	USB	dongle,	
which	plugs	into	an	available	USB	port	and	translates	the	MIDI	
messages	from	the	Xkey	Air.	With	this,	I	was	able	to	get	the	Xkey	Air	
working	with	all	of	the	above	devices.	While	Bluetooth	has	a	
reputation	(deserved	or	not)	for	being	unreliable	and	difficult	to	pair,	

the	Xkey	Air	+	WIDI	BUD	performed	flawlessly	with	everything	I	tried.	According	to	CME,	Xkey	
will	also	work	with	Android	and	Linux.	
	
Xkey	Air	Differences.	Although	superficially	the	Xkey	Air	looks	like	the	standard	Xkey,	there	are	
some	under-the-hood	differences.	First,	there’s	an	internal,	rechargeable	Lithium	battery	which	
CME	says	provides	about	10	hours	of	operation	on	a	single	charge	(charging	occurs	through	the	
USB	port).	However,	the	battery	does	not	appear	to	be	user-replaceable,	which	I	find	
problematic.	At	least	when	the	battery	loses	its	ability	to	hold	a	charge	someday,	you’ll	be	able	
to	use	the	Xkey	Air	as	a	USB	keyboard—but	that	defeats	the	purpose	of	buying	a	keyboard	to	
be	wireless.		
	
Second,	there	are	LEDs	to	indicate	Bluetooth/connection/power	status,	and	an	on-off	switch.	
This	needs	to	be	turned	on	when	using	USB.		
	
Third,	the	standard	37-note	Xkey	has	a	port	for	a	breakout	cable	with	MIDI	out,	and	¼”	jacks	for	
a	pedal	and	sustain	switch.	The	Xkey	Air	eliminates	this	port;	I	don’t	know	whether	it’s	for	
technical	reasons,	or	because	the	assumption	is	that	if	you’re	using	the	Xkey	Air	because	you	
don’t	want	wires,	well,	you	don’t	want	wires.	The	only	other	obvious	difference	is	a	sticker	on	
the	top	key	that	indicates	there’s	Bluetooth	functionality.	
	
What	about	Latency?	This	surprised	me:	CME	quotes	a	latency	spec	of	around	7	ms	(or	only	
slightly	more	than	a	standard	USB	keyboard),	and	given	the	response,	I	believe	it	does	indeed	
hit	that	“under	10	ms	latency”	sweet	spot	I	need	for	something	to	feel	responsive.	Latency	was	
not	an	issue	for	me	at	all,	nor	apparently	was	it	an	issue	for	the	several	big-time	musicians	who	
talk	about	it	on	a	video	on	the	cme-pro.com	website.		
	
Don’t	Lose	the	USB	Cable.	All	Xkey	models	ship	with	a	41”/104	cm	USB	cable	that	terminates	in	
a	micro-B	USB	connector	for	plugging	into	the	Xkey’s	USB	port.	The	connection	is	standard,	but	
the	plug’s	physical	size	is	thinner	than	the	USB	cables	you’ll	find	out	in	the	real	world,	because	
the	keyboard	itself	is	so	thin.	So	don’t	lose	the	cable—and	don’t	lose	the	WIDI	BUD	dongle	
either,	it’s	pretty	tiny.	
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Installation	Cautions.	CME	doesn’t	
provide	much	documentation	about	using	
the	Xkey	Air	with	Bluetooth.	When	I	tried	
conventional	pairing,	as	I	would	expect	
for	any	Bluetooth	device,	nothing	worked.	
Only	after	trial-and-error	did	I	figure	out	
that	I	didn’t	need	to—the	Xkey	Air	
automagically	connected	with	the	WIDI	
BUD,	which	dutifully	showed	up	as	MIDI	
I/O	in	SONAR’s	preferences	and	passed	its	
data	along.	It	seems	that	as	long	as	WIDI	
BUD	appears	in	Windows’	Control	Panel	>	
Settings	>	Connected	Devices,	you’re	good	
to	go	and	don’t	need	the	usual	Bluetooth	
pairing	procedure.	Also	note	that	the	
WIDI	BUG	has	a	red	LED	to	indicate	it’s	connected	to	USB,	and	that	when	you	send	it	data,	the	
LED	blinks…a	helpful	confirmation	that	all	is	well.	
	
The	Xkey	Plus	Software.	I	mentioned	this	in	the	previous	review,	but	there’s	been	a	major	
update	that	anyone	using	an	Xkey	should	know	about:	it	now	allows	saving	and	loading	presets.	
This	is	a	big	deal,	because	you	can	do	a	lot	more	than	trigger	notes	with	the	Xkey	(e.g.,	it	can	be	
a	Program	Change	generator)	and	there	are	many	customizable	elements.	Being	able	to	save	all	
your	setups	is	a	great	feature.		
	

Accessories.	Stage-strutters	will	appreciate	the	$49	
Xclip,	which	clips	on	to	the	37-note	version	and	adds	
guitar	strap-friendly	buttons.	You	also	have	a	choice	
of	two	carrying	cases,	the	$25	Supernova	which	holds	
the	37-note	version	(of	course,	it	holds	the	25-key	
version	too	if	you	don’t	mind	it	moving	around	inside),	
and	the	$40	Solar	case	which	is	designed	to	hold	both	
the	25-	and	37-key	versions.	However	the	Solar	
carrying	case	is	just	as	suitable	for	holding	the	37-key	

version	and	various	accessories,	like	the	USB	cable	and	a	USB	cable	extender.	
		
Curiosity,	or	Wave	of	the	Future?	
	
As	those	who	read	the	previous	review	know,	I	like	the	Xkey	keyboards	a	lot.	While	intended	for	
mobile	use,	I	have	the	37-key	version	within	easy	reach	when	sitting	at	my	computer;	the	
convenience	factor	is	huge.	I	also	love	that	it	has	polyphonic	aftertouch,	even	though	few	soft	
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synths	implement	poly	aftertouch	reception	properly	(which	unfortunately	includes	Cakewalk’s	
instruments).	Oh	well,	there’s	always	hardware…	
	
Furthermore,	these	keyboards	don’t	feel	cheap.	The	sturdy	construction	means	they	stand	up	
to	the	rigors	of	the	road.		The	foundation	is	brushed	aluminum,	and	despite	having	limited	
travel,	the	keys	respond	well	to	velocity.	It	doesn’t	take	much	effort	to	get	used	to	get	to	the	
low	“action.”		
	
But	there’s	also	the	matter	of	price.	The	standard	37-note	Xkey	costs	$199,	and	given	that	the	
Xkey	Air	will	likely	need	the	WIDI	BUD	unless	you’re	a	really	cutting-edge	kinda	gearhead,	the	
cost	goes	up	to	$348.	So	the	question	is	whether	it’s	worth	the	extra	bucks	to	you	to	cut	the	
cable;	I’m	sure	some	people	will	say	“Yes,	absolutely!”	while	others	will	say	“That’s	okay,	I’ll	
cope	with	a	cable	for	now.”	
	
Regardless,	I	get	the	feeling	this	isn’t	a	one-off	novelty	item,	and	that	we’ll	see	Bluetooth	LE	
make	further	inroads	into	the	studio	for	keyboards,	control	surfaces,	and	other	devices	that	
don’t	depend	on	audio	fidelity.	CME	has	done	a	really	good	job	of	making	wireless	BLE	practical	
even	if	you	don’t	have	the	latest	hardware,	so	if	you’ve	been	wanting	to	cut	the	keyboard	cable,	
that	day	has	arrived.	And	if	you	haven’t,	the	standard	Xkeys	are	better	than	ever,	thanks	to	the	
more	evolved	XKey	Plus	application	software.	
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Surfboard	
	
Surfing	the	boards	in	the	SONAR	forum	can	
uncover	a	wealth	of	great	tips,	like	these…	
	
SONAR	Platinum	on	Lowest-End	Hardware	
Can	you	really	run	SONAR	on	a	low-end	tablet?	
Software	developer	Alexey	Zhelezov	(azslow3)	put	
the	combination	through	its	paces,	files	a	detailed	
report,	and	comes	to	some	interesting	
conclusions—as	well	as	elicits	some	interesting	
comments	from	the	community.	
	
How	Do	You	Organize	Your	Projects?	
When	you’re	creating	a	lot	of	projects	with	SONAR,	
you	don’t	want	it	to	turn	into	a	giant,	uncurated	

mess	where	you	can’t	find	what	you	want,	or	don’t	know	what	it	was	done.	This	thread	
describes	several	useful	organizational	methods	that	have	worked	well	for	people	in	the	
community.	
	
Dark	Aqua	Theme	
When	it	comes	to	new	themes,	the	hits	keep	coming—and	community	member	TranceCanada	
has	come	up	with	some	beauties.	“Dark	Aqua”	is	a	beautiful	theme	that’s	easy	on	the	eyes,	and	
judging	from	the	response,	the	consensus	it	that	it’s	well	worth	the	download.	
	
No	Pentagon	in	Platinum	
This	older	thread	surfaces	from	time	to	time	because	of	Pentagon	fans	synth	who	are	
disappointed	they	can	no	longer	open	it	in	SONAR	Platinum.	But	it	is	possible,	and	this	thread	
mentions	the	various	ways	to	load	this	“vintage	digital	synth”	(with	an	actual	vocoder!)	into	
SONAR.	
	
Kontakt	5	is	Causing	SONAR	Platinum	to	Hang	
From	time	to	time,	perplexing	problems	crop	up	that	seem	to	have	no	clear-cut	answer.	But	
often,	the	forum	is	able	to	find	the	solution.	Ultimately,	the	solution	was	a	registry	change,	but	
the	process	of	trying	to	troubleshoot—even	if	some	suggestions	don’t	lead	to	the	right	
solution—can	reveal	what	to	look	for	when	encountering	similar	problems.	
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